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Q.1.Answer: The four fundamental units of computer are: Input units, The Central Processing Unit, 

The primary memory and the output units. 

1. Input units -The devices to input information, such as a keyboard and mouse. 

2. The Central Processing Unit or CPU – The CPU is further broken up into ALU, Control unit and 

Instruction unit.  

3. The primary memory- Computer program instruction converted into machine code are 

stored in primary storage or memory. 

4. The output units- The devices to output information, such as a printer, monitor and speaker 
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Q.2.Answer: The classification of computer based on size capacity are as follow: 

1. Super computer: It have thousands of processors. Because of their extraordinary speed, 

accuracy and processing power, supercomputer are well suited for solving high complex 

problems and huge amounts of calculations. Example: JAGUAR, ROADRUNNER, etc. 

2. Mainframe computer: They are very large often filling an entire room and can process 

thousands of millions of instructions per second. In a mainframe environment, users connect 

to the mainframe through the many terminals wired to the mainframe. Mainframe are 

capable of supporting hundreds to thousands of users simultaneously. Example: IBM 

mainframes Z13, etc. 

3. Mini computers: Minicomputers are much smaller than mainframes. These computers are 

also less expensive. Sometimes referred to as Midrange Server or Midrange Computer. They 

are typically larger, more powerful and more expensive than the desktop computers. 

Example: Apple iPod, CDC 160A. 

4. Micro Computers: Micro computers are the most frequently used type of computer. It is also 

known as Personal computer. A microcomputer is a small computer system designed to be 

used by one person at a time. Example:  Desktop computers, laptops. 

 

   

 

Q.3.Answer: The generation term was used to distinguish between varying hardware technologies. 

Nowadays, generation includes both hardware and software, which together make up an entire 

computer system. As of 2020, there are five generations of the computer. Vacuum tubes, transistors 

and the microprocessor were the technologies that are used.   
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Q.4.Answer: Volatile memory: It is a computer storage that only maintains its data while the device 

is powered. Example: RAM (Random Access Memory) While 

Non-volatile memory: It is a type of computer memory that has the capability to hold saved data 

even if the power is turned off. Example: ROM (Read Only Memory). 

 

Q.5.Answer:1) System Software: It is a type of software that is designed to run a computer’s 

hardware and application software like operating systems, compliers, editors and deliver, come 

under this category. 

2) Application Software: It is software created for a specific purpose, used by end users. It can be 

called an application or simply an app. Examples: Word processor, accounting application, a web –

browser. 

3)Open source software: It is a type of computer software in which source code is released under a 

license in which the copyright holder grants users right to study, change and distribute the software 

to anyone and for any purpose. The Linux operating system is the best known examples of open 

source software. 

 

   

 

Q.6.Ans. a) The steps involved are: 1) We click the Microsoft office button. 

                 2)We select now. Then the new document dialog box appears. 

                 3)We select blank document under the blank page and recent section. It will be highlight by  

                 Default. 

                4)We click create. A new blank document appears in the word window. 

                5)To save the document, we click again the Microsoft office button. 

                6)We click Ctrl+ S. The save as dialog box appears. 

                7)We select the location where we went to save the document using the drop-down menu. 

               8)We enter the file name “yourself” for the document. 

               9)We click the save button.  

  b) Steps to change the font size are: 1) We select the text or sentence we want to modify. 

                2) Left-click the drop down arrow next to the font colour box on the home tab. The font 

colour menu appears. 

                3) We move the cursor over the various font colours. A line preview of the colour will 

appear in the document. 

                4)Left-click the font colour we want to use. The font will change in the document. 

c)Steps to change the font colour: 1) We select the text or sentence we want to modify. 



              2) Left-click the drop down arrow next to the font colour box on the home tab. The font 

colour menu appears. 

              3) WE move cursor over the various font colours. A line preview of the will appear in the 

document. 

              4) Left-click the font colour we want to use. The font colour will change in the document. 

To highlight (in yellow) the line that read need to get IMS’s address: 1) We select the line that reads 

to get IMS’s address. 

               2) We select the highlight command and select yellow colour in the font group on the Home 

tab. 

 

Q.No.7. Ans. The steps involved in it are: 1) we click the Microsoft office button. 

                       2) we select new. The new document dialog box appears. 

                       3) we select blank document under the blank and recent section. It will be highlighted 

by default. 

                      4) we click create. A new blank document appears in the word window. 

                      5)we create the given documents from the question. 

                   6)we select the text “MS Word” and change the font size by clicking on the font size box 

on the home tab. 

                   7)we select the text “MS Word” to change the font colour into red, by clicking on the font 

colour menu. 

                   8)we select the text “word processor” and underline it by clicking the underline command 

in the font group on the home tab. 

                   9)we select the text “MS Word”to change the font style into italic by clicking italic 

command. 

                   10)we select the text we want to format as a list and click the bullet commands on the 

home tab. 

                 11)we change the font colour of the text “creating and saving” into blue and red 

respectively, by clicking on the font colour command, again we select the text “and” and click on 

strike through command. 

                 12)we select the text “printing any type of document” and change the font style into bold 

by clicking on the font style command. 

                 13)we save the file name as “MS - word” by clicking the Microsoft office button and select 

save as. 

                 14)we select the location where we want to save the document using drop down menu. 

                 15)we click the same button. 

Q.No.8. Ans. The steps involved are: 1) we create given document in MS Word. 



                   2) we select the text where we want to format and click on the subscript and superscript 

command on the home tab. 

                    3) we save the file name as ‘equation’ by clicking the Microsoft office button and select 

save as.  

                   4)we select the location where we want to save the document using the drop- down 

menu. 

                   5)we click Ctrl+ S or ‘Save’ button. 

Q.No.9. Ans. The steps involved are:  

                    1)we select the existing highlight text that we want to convert. 

                    2)we select the insert tab. 

                    3)we select the table command. 

                    4)we select convert text to table from the menu. If dialog box appears. 

                    5)we click ok. Then the text appears in a table. 

Q.No.10. Ans. The steps are:  

                  1)  We place our insert point in the document where we want the table to appear. 

                    2)we select the insert tab. 

                    3)we click the table. 

                    4)we drag our mouse over the diagram squares to select the number of columns and 

rows in the table. 

                    5)Left- click the mouse and the table appears in the document. 

                    6)we enter the text into the table. 

Q.11.Ans. 

Roll  No Name Marks 

1 n1 60 

2 n2 70 

3 n3 80 

4 n4 90 

5 n5 40 

6 n6 50 

7 n7 77 

8 n8 44 

9 n9 88 

10 n10 55 

 

Q.12.Ans. 

Roll  No  Name Marks 



1 n1 60 

2 n2 70 

3 n3 80 

4 n4 90 

5 n5 40 

6 n6 50 

7 n7 77 

8 n8 44 

9 n9 88 

10 n10 55    

 
Total 654  
Average 65.4  
Highest 90  
Minimun 40    

 

Q.13.Ans. a) To modify column width of a worksheet: 

                       i. Select a column or a range of columns. 

                      ii. Select a Home tab and in the cell group, select Format. 

                     iii. Click on Column width and type the width for column. 

                     iv. Select ok. 

           *To modify the row height of a worksheet: 

                     i. Select a row or a range of rows. 

                    ii. Select a Home tab and in the cells group, select Format. 

                  iii. Click on row height and type the height for row. 

                  iv. Select ok. 

          *To delete rows and columns of a worksheet: 

                   i. Select the cell you want to delete within the column or row. 

                  ii. Select Home tab. And in cells group click on Delete Sheet Column or Row. 

                                                          OR 

                  i. Select the desire row or column. 

                  ii. Right- click and select Delete. 

 

b) *Absolute Reference:  An absolute reference in Excel means there is a fixed point of reference 

applied to a cell or a formula. This is so return value will always stay the same no matter where the 

cell or formula moves to – within the same sheet or across different sheet. 



  

This reference to a fixed point of reference is a constant, and involves the use of dollar sign $ in the 

formula (i.e., everyone is to receive the same bonus payout, so the amount $1500 is constant in this 

situation). 

*Relative reference:   It is the default cell reference in Excel. It is simply the combination of column 

name and row number without any dollar ($) sign. When you copy the formula from one cell to 

another the relative cell address changes depending on the relative position of column and row. C1, 

D2, E4, etc. are examples of relative cell references. Relative references are used when we want to 

perform a similar operation on multiple cells and formula must change according to the relative 

address of column and row. 

    

 

 This refers to a relative point of reference, is constantly changing and dollar sign ($) is absent in the 

formula (i.e., when each unit price and quantity are difference variables, there’s no constant in the 

calculation). 

*Cell Address:  A cell address is a combination of column letter and a row number that identifies a 

cell on a worksheet. 

For example: A1 refers to the cell at the intersection of column A and row 1; B2 refers to the second 

cell in column B, and so on. 

         When used in formula, cell references help Excel find the values the formula should calculate. 

For instance, 

• To pull the value of A1 to another cell. You use this simple formula: =A1 

• To add up the values in cells A1 and A2, you use this one: =A1+A2 

 

 

Q.No.14. Ans. A)  Tools available to customize our PowerPoint presentation are:   

i) Perspector 

ii) Pivot Viewer 

iii) VisualBee PowerPoint Add-in 

iv)SmartArt 

v) Animations and Transition 

vi) Wordle 

vii) CA coo 

viii)Oomfo 

ix)Clip champ. 

 

 

b) * To open blank presentation: 

       i. Open PowerPoint presentation using ‘Run’ command (window key +) 

       ii. Select the ‘Blank Presentation’. It is opened. 

*Save the Presentation as Lab1.pptx.: 

       i. Select the ‘File’ on Tab bar.  



       ii. Click on ‘Save As’ option. 

       iii. Click on document/desktop as your choice. 

       iv. Type the name ‘Lab1.pptx’. 

       v. Click the ‘Save’ button. 

 

 

*Add a title to the first slide: the name of your college. 

    i. Left click on the ‘Click to Add Title’ section on the first slide. 

ii. Type the name of your college. 

          

*Type your first name and last name in the subtitle section: 

i. Left click on the ‘Click to Add Subtitle’ section. 

ii. Type your first and last name. 

*Add a New slide which has a title and content. 

    i. Select the Home tab. 

     ii. Click on the dropdown button of the ‘New Slide’ on toolbar. 

     iii. Select the slide having ‘Title and Content’. It is added. 

Q.No.15. Ans. a) Title and bullet list: 

             i.  Open PowerPoint presentation. 

             ii. Select the Home tab. 

            iii.  Click at the dropdown button on ‘New Slide’ at toolbar. 

             iv. Select the slide having ‘Title and Content’. It is added. 

 

*Inserting Excel sheet:   

      i. Open the slide where you want to insert the Excel Sheet. 

     ii. Select the ‘Insert tab’. And click on ‘Object’ on toolbar. 

     iii. Select the Microsoft Excel Worksheet’ object type. 

     iv. Click ‘OK’ button. 

*ClipArt and Text: i. Select the Insert tab. 

      ii. Select the ‘Pictures’ or ‘Online pictures’ on toolbar. 

       iii. Choose the appropriate art for the topic. 

       iv. Click on the ‘Insert’ button. 

*Slide show effects: 

       i. Select ‘Design Tab’ for themes, variants and slide size. 

      ii. select ‘Transition Tab’ for Cut, fade, push, wipe, split, reveal, shape, flash, etc. for 

slide effects. 

  

 

 

 

 

 

 

 

 

 



 

Q.16.Ans. The difference between Machine Language and High level language are as follows: 

                Machine Language 
1)A computer programming language 
consisting of binary instructions which a 
computer can respond to directly. 

         High level language 
1)A high level language is a programming 
language with strong abstraction about the 
details of the programming language.  

2)Example: 01001000, 01100101, 
01101100, etc.  

2)Example: C, C++, Java. 

 

Q.No.17. Ans. The different data types of C programming language are: Each variable in C has an 

associated data type. Each data type requires different amounts of memory and has some specific 

operations which can be performed over it. Let us briefly describe them one by one. 

          Following are the examples of some very common data types used in C:  

1)Char: The most basic data type in C. It stores a single character and requires a single byte of 

memory in almost all compilers. 

2) int: As the name suggests, an int variable is used to store an integer. 

3)float: It is used to store decimal numbers (numbers with floating point value). 

4)double: I t is used to store decimal numbers (numbers with floating point value but its range of 

value is high in comparison to float. 

Q. No. 18.Ans. a) X= 20/ 5*2+30-5 

                              X= 4*2+30+5 

                              X= 8+30+5=38-5 

                              X=33. 

          b) Y=30-(40/10+6) +10 

             Y= 30-(4+6) +10=30-10+10 

             Y=40-10 

             Y=30. 

       c) Z= 40*2/10-2+10 

     Z=40 *0.2-2+10 

     Z=8-2+10=18-2 

    Z=16. 

Q.No.19. Ans. a) If- else statement: if statement can be followed by an optional else block of 

statements, which executes when the Boolean expression is false. 

       Syntax 



       If (expression) 

         { 

        true block of statements; 

          } 

        else 

         { 

          else block of statements; 

         }. 

b) for loop: for loop is similar to while. Basic syntax of for loop is as follow: 

     for (expression 1; expression 2; expression3)  

         { 

          Block of statements; 

          } 

     In the above syntax:  

i)expression 1- Initializes variables. 

ii)expression 2- Conditional expression, as long as this condition is true, loop will keep executing. 

iii)expression 3- expression 3 is the modifier which will increase or decrease the value of the 

variable. 

c)while loop: Basic syntax of while loop is as follows: 

                      while (condition) 

                                 single statement; 

         or 

                     while(condition) 

              { 

                   Block of statements; 

               }. 

d)do-while loop: do…while is just like a while loop except that the condition is checked at the end of 

the loop rather than the start. This has the effect that the body of the loop are always executed at 

least once. 

Basic syntax of do…while loop is as follow: 

        do 

         { 



           Single statement 

                      Or 

       Block of statements 

       } while (condition); 

Q.No.20. Ans. a) IMS Ghaziabad. 

                         b) IMS Ghaziabad. 

                              IMS Ghaziabad. 

                             IMS Ghaziabad. 

                         c) Largest number is 100. 

 

                   

 

     

                 


